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Lab 10   Hyperspectral 
Utilizes Textbook’s Remote Sensing Digital Database: Chapter 9 data. 

The objectives of this lab are to become familiar with hyperspectral data, learn about 
spectral libraries and different methods for processing hyperspectral data.  The tasks 
we will complete with this lab are done with tools in the ENVI Toolbox.   

Two hyperspectral datacubes are available to be analyzed. The first datacube has VNIR 
data and is analyzed for vegetation.  The second datacube has SWIR data and is 
processed for minerals.  Different image processing tools are utilized with each 
datacube.  Lab time may be a limiting factor for both datacubes to be processed and 
analyzed in one session.   

Therefore, this lab exercise is clearly separated into two sections – with the first section 
utilizing the hyperspectral VNIR datacube (pages 2 – 8) and the second section 
analyzing the hyperspectral SWIR datacube (pages 9 – 25).  

The VNIR vegetation section has two digital uploads to be uploaded to the instructor 
and six questions to be answered on the last pages of this handout (page 26).  The 
SWIR geologic section has one digital file to be uploaded to the instructor and eleven 
questions to be answered on the last pages of this handout (pages 27 and 28). 

The VNIR vegetation section includes the following image-processing tasks: 
 - Normal and continuum removed spectral profiles. 
 - Using the chlorophyll absorption feature to document vegetation vigor. 
 - Editing spectral profiles for presentation. 
 - Building a 3D cube. 
 - Minimum Noise Transform (MNF). 
 - Unsupervised classification of select MNF bands. 

The SWIR geologic section includes the following image-processing tasks: 
 - Using the USGS Spectral Library converted to the 50-band SWIR dataset. 
 - Comparing spectral profiles at select pixels with published mineral maps. 
 - Using the Spectral Library Viewer and adding/deleting files. 
 - Using ENVI’s “Spectral Hourglass Wizard”. 
  Data dimensionality determination,  
  Pixel Purity Index (PPI),  
  n-Dimensional Visualization, 
  Spectral Analyst tool. 
  Spectral Angle Mapper (SAM) classification. 
  SAM Rule images. 
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Hyperspectral VNIR Datacube for Vegetation Analysis   
The first datacube was acquired over semi-arid terrain of the High Plains in central 
Colorado.  This datacube contains 128 bands of reflected VNIR wavelengths.  The data 
is courtesy of Galileo Group, Inc.  A white paper by Galileo is included in the folder 
containing the datacube – it is highly recommended that you review this 22-page 
overview of commercial hyperspectral capabilities and case histories. 

The datacube is in the Chapter 9 folder of the Remote Sensing Digital Database.  The 
subfolder “AISA_VNIR_Hyperspectral” contains the datacube, a USGS topographic 
map, and metadata. 

1) Start-up ENVI   > drive to the “Ch_9_Image_Processing \ AISA_VNIR_Hyperspectral” 
 folder   >      Select “AISA_Semiarid_Hyperspectral_VNIR_ENVI”   and  
    “ESRI  USGS TOPO Basemap_GIS.tif  > Open 
 
 We use the ENVI version of the datacube because it displays the center 
 wavelength of each band.  The GeoTIFF version does not and you have to refer 
 to the folder named  “Table of AISA VNIR bands and wavelengths”. 

 The datacube automatically opens as a color IR image  
  (Band 90 - Band 65 – Band 38 or NIR-Red-Green as R-G-B) 

 Drag the topo map beneath the color IR image in the View. 
 Zoom in so the color IR image fills your View. 

 Open the “Data Manager” to see the list of 128 bands with their wavelength. 

2)  Highlight (select) the hyperspectral file in the Layer Manager >  
 Display > Profiles > Spectral 
 With your cursor (the “Select” arrow is highlighted), Click-on bright red pixels and 
 note how the spectral signature of pixels remains relatively constant. 

 The units of the horizontal axis are nanometers.  The Data Value on the vertical 
 axis is a measure of brightness or reflectance. 

 Click-on the Options drop-down menu and select “RGB Bars” to see where the 
 3 bands displayed in the ENVI View are located in the VNIR spectrum. 

 Click-on the small black triangle in the white band on the right side of the 
 “Spectral Profile” menu to display properties of the plot. 
  Scroll down the “General” and “Curve” menus. 
  You can change the symbology, name, and range of wavelengths   
  displayed with these menus.  
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 With your cursor, click on the spectral profile line to see the exact wavelength 
 and brightness (Data Value) for that part of the profile 
 
3)  Review Figure 9-37A and B and the text in the textbook’s Chapter 9. 

 Click your cursor on a brightest red pixel (most vigorous vegetation) in the scene.  
 This spectral profile is unique to vegetation. 
 
Question 1: What is the name of the unique sharp increase in brightness (Data Value) 
between 680 and 745 nanometers? 

Question 2: Why is the reflected brightness highest in the 520 – 600 nm range 
compared to the 400 – 520 nm and the 600 - 680 nm ranges? 
 

 There is another way to view spectral profiles named “Continuum Removed”.  
 This type of profile is generated by the algorithm fitting a “convex hull” arc over 
 the top of the spectrum.  The continuum removed spectral profile is very useful 
 for evaluating absorption features (depth, shape, and width). 

 Click-on the “Y: Data Value” drop-down menu at the bottom of the Spectrum 
 Profile window.  Choose “Continuum Removed” 
 The shape of the spectral profile changes to highlight absorption features. 

Question 3:  What causes the unique absorption feature for healthy vegetation that is 
between ~600 and 680 nm?  (Hint: think about what is causing the higher reflectance 
values at shorter and longer wavelengths). 
 

 The name of the deep absorption feature unique to vegetation that is revealed 
 with the “continuum removed” tool is the “chlorophyll absorption feature”.   
  
 Click-on the “Options” drop-down and select “Vegetation Index (NDVI)” 

 
Question 4:  A. What is the calculated NDVI value for your brightest (most vigorous)  
  pixel? 

  B. What is the calculated NDVI value for the gray terrain (in the color IR  
  image gray may represent dormant, dry grasses and other ground   
  vegetation)? 

  C. How did the program calculate NDVI?   
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4) Let’s move our cursor around the image clicking on five pixels that represent a trend 
from most vigorous vegetation (bright red), to less vigorous vegetation, to the gray 
terrain (dry vegetation?) to barren ground on the road (white pixels).  Place your cursor 
on a bright red pixel to start this task - the deep chlorophyll absorption feature is 
redisplayed in the “Spectral Profile” window. 

 We will stack these five spectral profiles in one window so we can compare the  
 signatures.  Click-on the icon at the bottom of the Spectal Profile window that 

 looks like a staircase    This stacking feature is only active when the icon is 
 highlighted.  

 You have to press the Shift key on your keyboard when you click on the image to 
 collect a spectral signature in order for the spectra to stack in the profile window.
 Have the Properties window (right side of the Spectral Profile window open so 
 you can delete spectra you don’t like. 

 You can edit the names of the 5 spectra, change the line thickness, and add a 
 legend to the side so that this change in a spectral signature as vegetation cover 
 becomes less vigorous or is reduced for a report.  An Example is below with the 
 Properties menu open so that you can see where some changes were made. 

                
 You can Export the spectral profiles and the legend to several different graphic 
 formats (see .png graphic below).   This makes the spectral work you have done 
 more accessible to others who don’t have or want to do image processing.  
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 For this lab, it is an option to customize your 5 spectral profiles so you can learn 
 about the symbology tools in ENVI.  Use the “Curve” tab to customize your 
 legend.  Use the “General” tab to add the legend to the Export, change line 
 thickness, etc.  The symbology work takes some time…but is worth it if you are 
 going to present your results to others. 

 Export > Image   >  Name the plot “YourName_5_Spectral_Profiles” as a .png. 

 Upload your png graphic to the instructor. 

Question 5:  Discuss in 2 or 3 sentences what happens to VNIR spectral profiles when 
you move from vigorous vegetation to no vegetation (barren terrain). 

 
5) Let’s visualize the data cube. 
 ENVI Toolbox > Spectral > Build 3D Cube  
 Select the 128 band datacube > OK 

 For the front of the datacube, let’s generate a color IR image using the same 
 bands as were automatically displayed in the View by ENVI (these three bands 
 are designated in the metadata for automatic display).  Select the following 3 
 input bands: 
  R = Band 90 
  G = Band 65 
  B = Band 38   > OK   > the “”3D Cube Parameters” window pops-up 

  Accept defaults (rainbow color scheme and spectral scale) 
  Name the visualization “Colorado_3D_cube” 

 The processing may take 1-2 minutes. 
 The 3D cube is an ENVI .img file with .hdr header.   
 This format is not useful for a report graphic.    
 Let’s save our 3D cube as a full resolution, .tif.   

  Uncheck the topo map. 
  Zoom in to the datacube so it fills your view. 
  File > Export View To > Image File      
  Ensure “Output Extent” is Current”  
  Leave “Zoom Factor” as 1.000 
  Change Output Format to “TIFF”   
  Uncheck “Display result” 
  Name the 3D cube “YourName_3D_Datacube”  > OK 
  Upload your excellent graphic to the instructor. 
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6) To help understand the richness of the hyperspectral data, we can compress the 128 
bands with an algorithm named “Minimum Noise Transform” (MNF) which is similar to 
Principal Components.   Open Help and search for  “MNF” to learn more – a lot more 
about MNF.  MNF Rotation transforms determine the inherent dimensionality of image 
data, segregate noise in the data, and reduce the computational requirements for 
subsequent processing (Boardman and Kruse, 1994). 
 
We will run the MNF program, select those grayscale MNF bands that contain the vast 
majority of variance and little noise, and then perform an unsupervised classification on 
the selected MNF Bands to determine if this enhancement improves our understanding, 
pattern recognition, and mapping of vegetation, soils, and clearings . 

ENVI Toolbox > Transform > MNF Rotation > Forward MNF Estimate Noise Statistics 
  Select the AISA 128 band hyperspectral data   > Open 
  Accept defaults on the MNF Transform Input File  > OK 
 
  The “Forward MNF Transform Parameters” window pops-up 
  Output Noise Stats Filename: “VNIR_MNF_noise_” 
  Output MNF Stats Filename:  VNIR_MNF_stats” 
  Output Filename: “VNIR_MNF_128bands”    >  OK 

  The computation of MNF bands will take some time – be patient. 

  When done, the 128 MNF bands appear in the Data Manager and a color  
  composite of MNF Band 3 – 2 - 1 as R – G –B is displayed in the View. 

  The MNF Eigenvalues plot also appears (VERY similar to the PC plot) 
 

The MNF Eigenvalues plot 
 
Note the rapid drop-off in Eigenvalue. 
 
This plot indicates that most of the original 
information in the data cube (variance) is 
now contained within the first 10 to 15? 
MNF bands. 
 
We will use the Band Animation tool to 
examine the MNF bands and create color 
composites to determine how many MNF 
bands we will use going forward. 
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7) Determine the number of MNF bands for further processing.  Zoom-in so the image 
fills your view. 
 If the MNF image in the View is black, click “Linear 1%” 
 Right-click on “VNIR_MNF_128bands” file in Layer Manager 
 >  Band Animation        
 You may have to stop Band Animation and stretch the MNF file in the Layer 
 Manager with “Linear 1%” 
 Keep moving the slider back to 1 after you start to see too much noise 
  Set timer for 1 second  

 MNF Band 1 has noise and all bands >10 to 15 have excessive noise? 

 Close the Band Animation tool   > Use the Data Manager to generate color 
 composites from MNF Band 2 to MNF Band 10.  Evaluate quality. 

 We will create a new MNF Band dataset with bands 2-10  
  File > Save As > Save As (ENVI, NITF…) “Data Selection” menu pops-up  
  “VNIR_MNF_128 bands” should be highlighted.   
  > Click “Spectral Subset” > Select bands 2 – 10 > OK  > OK 
  Name the output file “VNIR_MNF_9bands” in ENVI format   >  OK 

8) The 9-band MNF dataset appears in the Data Manager.  You may have to load a 
color MNF 4-3-2 as R-G-B using the Data Manager to have the 
“VNIR_MNF_9bands.dat” file appear in the Layer Manager. 
 
9) We’ll run an unsupervised classification on the 9-band MNF file to determine if new 
information is seen compared to the color IR and other band combinations. 
 
ENVI Toolbox > Classification > Unsupervised Classification > IsoData Classification 

 Choose the “VNIR_MNF_9bands.dat file”  >  OK 

 The ISODATA Parameters window pops-up. 
 Change the Max number of classes to 15 
 Change Maximum Iterations to 15 
 Change Threshold % (0-100) to 3.00 
 Accept other defaults Press “Help” to learn what these parameters mean. 

 Output Filename :  “VNIR_9-MNF_iso_15cla”   > OK 

10) If not already done, change to 2 vertical Views.  Have the unsupervised 
classification in one view and the color IR image in the second view.  Link the Views. 



8 
 

8 Introduction to Remote Sensing  Principles, Interpretation, and Applications 
F. F. Sabins and J.M. Ellis, 2020, Waveland Press.    Contact:  jellis@ellis-geospatial.com 

 

Question 6:   A. Do you think there is new information and patterns in the classification  
  map about vegetation, soils, barren ground, etc. that made our MNF and  
  isoDATA effort worthwhile?   

  B. Do you see shadows in the classification map?  If so, what class   
  number represents many shadows? 

  C.  What class number represents the most vigorous vegetation? 

Close all files in the Data Manager.  Return to one blank View. 
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 Hyperspectral SWIR Datacube for Geologic Mineral Mapping  
The second hyperspectral datacube is in the Chapter 9 folder of the “Remote Sensing 
Digital Database” in the “Ch_9_Image_Processing \ Dig_Img_1-2_Hyp-Multi_Cuprite-
NV” subfolder.  Digital Image 1-2 shows the Cuprite, Nevada area of interest. 
 
File > Open  drive to the “Dig_Img_1-2_Hyp-Multi_Cuprite-NV” folder, and open the 
“AVIRIS SWIR 50 bands” subfolder.   We will be working with only SWIR data. 
Select “cuprite_AVIRIS95_atm_50-SWIR_ENVI_” > Open 
 Apply a Linear 1% stretch 

 Open the Data Manager.  Select Bands 214 – 193 – 173 as R-G-B  > Load Data 

File > Open  return to the  “Dig_Img_1-2_Hyp-Multi_Cuprite-NV” folder and open the 
“Cuprite_Geology_Maps” folder.   We will load two geology maps. 
 Select “Field_Alteration_Zones_Ashley-Abrams_GIS.tif” and  
  “USGS Hyperspectral Map_GIS_JARS_9_1_0960044.tif” 

1) Cuprite is in the mining district of Nevada, located about 200 km northwest of Las 
Vegas.  Hydrothermal alteration is extensive at Cuprite.  There are three mapped zones 
(silicified, opalized, and argillized) that include mineral assemblages (see below).  The 
silicified zone contains abundant quartz, chalcedony, minor alunite, kaolinite and post-
alteration calcite.  Opalized rocks (opalite) contain opal with variable amounts of 
kaolinite and alunite, and  minor calcite.  Argillized areas are typically within or adjacent 
to opalized zones and contain primary quartz, unaltered sanadine, opal, montmorillonite 
and kaolinite. (Kruse, Baugh, and Perry, 2015, Validation of DigitalGlobe Worldview-3 
Earth Imaging satellite shortwave infrared bands for mineral mapping: Journal of 
Applied Remote Sensing, SPIE, v. 9, p. 096044-1 to 096044-17). 

 
Ashley and Abrams, 1980, USGS Open File Report 80-367.  



10 
 

10 Introduction to Remote Sensing  Principles, Interpretation, and Applications 
F. F. Sabins and J.M. Ellis, 2020, Waveland Press.    Contact:  jellis@ellis-geospatial.com 

 

Kruse, Baugh, and Perry (2015) also provide the USGS hyperspectral mineral map and 
legend (available in the Remote Sensing Digital database as “USGS Hyperspectral 
Map_GIS_JARS_9_1_096044.tif” and “Hyperspectral Legend” (see below). 

 
To see this legend picture on your screen, drive to the “Lab_11_Data” or the 
“Cuprite_Geology_Maps” folder and open “Hyperspectral_Legend.tif”.  You can see and 
enlarge this legend on your computer screen with any computer picture viewer program 
while mapping in ENVI. 

Next we’ll be comparing the geology maps, legend, and AVIRIS SWIR color image. 

 

2) To expedite this lab, I used the USGS Mineral Spectral Library (available from the 
USGS; in ENVI available as “usgs_min.sli” ) that was developed with detailed VNIR-
SWIR signatures of minerals in a laboratory setting, and I converted this library to a 
spectral library that fits the airborne AVIRIS 50-band SWIR data.  Then I extracted 14 
minerals that were mapped by the USGS at Cuprite (see legend above) and created a 
new spectral library for this lab’s AVIRIS 50-band SWIR data.   

This focused spectral library is named            
   “USGS_Min_Spec_Cuprite_50band_14minerals.sli”  
and is found in the Lab_11_Data folder.     
 

The 14-mineral Cuprite library is shown below.  The list of minerals on the right is shown 
as spectral signatures in the reverse sequence on the left.  Note the red alunite band is 
at the bottom of the spectral signatures and at the top of the list on the right.  Many 
unique absorption features that are used to identify minerals occur at different 
wavelengths. 
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NOTE:  My 14-mineral spectral library (above) has significant limitations because I did 
not account for differences in composition when creating the Cuprite 14 mineral spectral 
library. Many minerals have more than one entry in the “usgs_min.sli” spectral library 
because of differences in composition.   

Quartz does not have a diagnostic spectral absorption feature in the SWIR 
wavelengths.  Opal, sanadine and chalcedony also lack an absorption feature.   They 
are included in the 14-band spectral library as field work by Ashley and Abrams (1980) 
confirmed their occurrence at Cuprite. 

3) You should have the 50-band SWIR data, the color geologic map and the grayscale 
map in your ENVI display.  Open the USGS color mineral legend (shown above) with a 
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picture viewer and place it next to the ENVI display so you can more easily correlate 
colors on the map displayed in ENVI with the legend.   

 
Example of the set-up for one computer screen that includes the ENVI display, Data 

Manager, Toolbox, and the USGS color legend as a floating picture.  The color map is 
interactively made transparent and opaque with the slider to help pick sites for a 

spectral profile.  

3) Let’s compare spectral profiles in our hyperspectral data to spectra in the USGS 
spectral library.   

a) Zoom-in so the hyperspectral image fills your View.  Click-on the grayscale map and 
click-off the color map.  Turn the grayscale map on & off so you can compare the map 
patterns to patterns on the hyperspectral image.  The  “Silicified” pattern can be seen on 
the image.  
  
b) Notice that the map does not fit the image very well – the image is not orthorectified 
so distortions due to topography are inherent and both maps were screen-captured from 
the pdf publication so they also have inherent distortions.  
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c) Click-off the grayscale map and click-on the color geologic map. Use the 
transparency slider to compare the patterns on the color map with the hyperspectral 
image.  Use the Data Manager to load any grayscale band.  The color map when 
partially transparent will be easier to compare with patterns on a grayscale band– it will 
be more apparent when the map is not aligned with the image.  

d) Set the transparency for the color map at 40%, 
 Highlight the 50-band hyperspectral data in the Layer Manager. 
 Click-on the Spectral Profile tool (or use Display > Profiles > Spectral). 

e) The Spectral Profile window pops-up. 
 Move your cursor to the bright red pattern (“K-alunite 1” mineral) that is mapped 
 on the western hill.  “K-alunite” and “alunite1” are the same in this lab exercise. 
 Move your cursor to different locations in the red, K-alunite outcrop pattern. 
 Notice how consistent the absorption feature is at ~2.17 µm.  Place your cursor 
 on the bottom of this absorption feature and see the wavelength value in red 
 numbers at the bottom of the window. 

 To better interpret absorption feature wavelengths and shapes, click-on the “Data 
 Value” drop-down menu below the spectral profile . 
 
 Choose “Continuum Removed”.  Now click around the red pattern and observe 
 the consistency and variation in the ~2.17 µm absorption feature. 

 Keep the Spectral Profile window open – we will compare the airborne AVIRIS 
 profile in this window to the USGS spectral library profile of alunite next. 

f) We open the 14-mineral spectral library that is in the Lab_11_Data folder.   
  File > Open   drive to the Lab_11_Data folder   
  Select “USGS_Min_Spec_Cuprite_50band_14minerals.sli”  > Open 
   The “Spectral Library Viewer” window pops-up. 
   The 14-band library is open on the left side of the window.   
   Select “alunite1…” 
 
   Move the library window with the spectral profile under the spectral  
   AVIRIS spectral profile for alunite so the two profiles are aligned. 
   See example to left. 

   Open the Properties menu (black triangle on the right side) of the  
   Spectral Library Viewer so you can see the mineral that is   
   displayed, and can delete profiles as needed. 
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 Compare the shape and wavelength of the K-alunite1 (red pattern) spectral 
 profile on the geologic map and in the USGS Spectral Library.  Click around the 
 alunite outcrop on the geologic map with your spectral profile tool. 
 
 Alternate profile display between “Continuum Removed” and “Data Value” 
 
Question 7:   A. Do you find the absorption feature of alunite is relatively consistent  
  between the pixels in the hyperspectral data set and the USGS Spectral  
  Library?   YES  NO 

 

NOTE:  Most pixels are mixtures of minerals – there are very few pixels in a scene 
characterized by only one mineral – pure pixels are named “end members”.  So you will 
see variation in the shape and perhaps in the wavelength of the absorption feature for 
most pixels in the scene.  

g)  Move and Click your cursor on the bright green pattern on the color map (lower left). 
Your outcrop has to be within the smaller area covered by the AVIRIS image!  A new 
spectral profile from the 50-band SWIR hyperspectral data is displayed.  Click around 
the green pattern – is the spectral profile consistent?  
 
 In the “Spectral Library Viewer”, find the one mineral in the USGS library that 
 matches the mineral represented by the bright green color on the map.   
  Select and delete the “alunite1…” and other profiles you try out in the  
  properties menu for clarity. 

Question 8:  A. What mineral is represented by the green color in the USGS color map?  

  B. What is the wavelength of the absorption feature in both the   
  hyperspectral data and in the spectral library? 

 
h) Kaolinite, Dickite, and Halloysite are clay minerals with similar chemical and physical 
properties.  They are common in hydrothermally altered terrain. 

 Display these three clay minerals in the Spectral Library Viewer. 

 Click inside the yellow pattern on the color map (well-ordered Kaolinite). 
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Question 9:   A. Do you find pixels with the deepest absorption feature at ~2.21 µm? 
  YES  NO 
 
  B. Do you find pixels with the “doublet” absorption feature?  (two   
  absorption features next to each other)  YES  NO 

  B. What is the wavelength for the deepest absorption feature for dickite  
  and halloysite in the spectral library?  

i) Add “muscovi1” (muscovite = white mica) to the Spectral Library Viewer. 
 
 Click-on many pixels in the blue pattern (White mica 2) on the color   
 geologic map and analyze the spectral profiles. 

 Click-on many pixels in the orange pattern (White mica 3) on the color   
 geologic map and analyze the spectral profiles.   

Question 10:  A. What is the wavelength of the absorption feature for “muscovi1” (white  
  mica) in the spectral library? 

  B. Describe the difference between the shape of the absorption feature of  
  kaolinite and  muscovi1 (white mica). 

j) Remove all the minerals from the Spectral Library Viewer except kaolinite (“kaolini1”).  
Reload “alunit2” into the viewer.    Think about what would happen to the absorption 
feature between ~ 2.15 and 2.23 µm if you mixed kaolinite and alunite.   
 Click around the “Alunite + kaolinite” pattern on the color map. 
 
Question 11:  A. What often happens to the depth of the first absorption feature in the  
  kaolinite doublet (~2.16 µm) when alunite is mixed in? 
 
NOTE: The spectral profiles of pure pixel end members are used to unmix the minerals 
in mixed pixels…and theoretically estimate what percentage of each mineral is in the 
mixed pixel.  Finding pure pixels (end members) and “Unmixing” are often major goals 
of hyperspectral processing. 

k) Close the Spectral Library Viewer and the Spectral Profile windows. 
 Uncheck all the layers in the Layer Manager except the 50-band hyperspectral 
 data set 
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A good way to learn about hyperspectral processing is to use ENVI’s “Spectral 
Hourglass Wizard” (created by J. Boardman and F. Kruse).  The wizard has extensive 
explanations for the many processes – and many warnings about not letting your 
processing blindly follow the automated steps and results.  Always look at the input and 
output data.   This lab can only touch upon some of the steps – if you are interested in 
hyperspectral processing work with the wizard on your own. 

 

 

 
1. Input/Output File Selection (input data are usually 
in reflectance) 
2. MNF Transformation to reduce spectral 
dimensions 
3. Review of MNF Results 
4. Data Dimensionality determination using Spatial 
Coherence measures 
5. Pixel Purity Index (PPI) to reduce spatial 
dimensions 
6. Review of PPI Results 
7. n-Dimensional Visualization, including auto-
clustering, to select and retrieve individual 
endmembers 
8. The option to manually add User Supplied 
Endmembers 
9. Spectral mapping using Spectral Angle Mapper 
(SAM) and/or Mixture-Tuned Matched Filtering 
(MTMF) 
10. Investigation of Mapping Results 

 
As you gain experience with hyperspectral data, try ENVI’s Toolbox’s many tools in the 
Spectral, SPEAR and THOR Folders. 

ENVI Toolbox > Spectral > Spectral Unmixing > Spectral Hourglass Wizard 
 INTRODUCTION page  -  READ the text for each step!   
 

j) After reading the first page, press > “Next”  
 SELECT INPUT/OUTPUT FILES page 
 select our 50-band SWIR hyperspectral dataset for input.   
 Select an output folder for the many files that are produced.     
 > Next 
 
 1)   FORWARD MNF TRANSFORM page 
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       Accept Defaults  input “50” MNF bands 
 
       Do not use “Shift Difference Spatial Subset…” 
 
        >  Next   
 
       MNF Eigenvalues” plot pops up (see plot to right). 

 
  

 Do you see a flattening of the MNF curve after “10” ?   
     (10 of the 50 MNF Eigenvalue bands have a value above 1.8538.                
     The remaining 40 MNF bands have very little data variance – mostly noise). 

 2) > Next   VIEW MNF RESULTS page 
   “Load MNF Result to ENVI Display….”   
  The wizard may automatically fills the ENVI Classic 3-window display and  
  the newer GIS-look display.  Look for the list of MNF bands in the Data  
  Manager. 
  
  Apply “Linear 1%” stretch if image is black. 

   “Load Animation of MNF Bands…”  If this window does not appear, look  
  in the  Windows Taskbar at the bottom of your computer screen to   
  display…. 
  Slow the animation down with Speed “1”  More effective to hit the “Pause”  
  symbol and manually work your way back and forth through the bands  
  with the black arrows. 

Question 12:  A. What do you visually see as a reasonable number of MNF bands to  
  use going forward?  (relatively clean data, not much noise). 

 3) > Next   DETERMINE DATA DIMENSIONALITY page 
  We see the MNF Eigenvalues plot again – with a black background. 

  Accept defaults (50)  > Calculate Dimensionality 

  The “Spatial Coherence Threshold” plot shows up.  Move the horizontal  
  red line up and down number (use your cursor in the plot or the arrows).   
  Each Threshold Level specifies the number of bands above the threshold. 
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Question 13: A. What “Threshold Level” did you decide to use and how many MNF  
  bands does the ENVI program recommend using going forward?   

  B.  Why the difference between what you saw with your eyes and what the 
  computer program specifies as good MNF bands to use going forward?  
 To achieve lab class consistency, let’s type in“20” as the number of MNF bands 
 to retain going forward.  Type “20” into the Data Dimensionality window. 

 4) > Next   DERIVE OR SELECT ENDMEMBERS page 

  Choose to Derive Endmembers from Image “Yes”  > Next 

 5) PIXEL PURITY INDEX page 
  Accept the PPI defaults (5,000 iterations, threshold value 2.5,  
  memory use 10.0 Mb.   > Next 

 

 6) EXAMINE PPI RESULTS page    Accept 10,000 default   > Next 

 7) N-DIMENSIONAL VISUALIZER page   Read the discussion on this page! 
  Enlarge the “n-D Visualizer” window  > Start 
  Reduce speed to 10.  Be amazed by the cloud with end members 
  These are “pure” pixels color-coded by the ENVI wizard. 

 

Examine the drop-down menus in the “n-D Controls” window. 
  Options > Show Axes 

  Options > Class Controls 

NOTE: 
I found  20,000 iterations on a fast workstation 
provided a curve that flattened more compared to 
the default 5000 iteration curve. 
If you are on a fast computer, try increasing your 
iterations and maximum memory. 
 
You want to flatten the curve in the upper right. 
 
A PPI image with a grid pops up on the ENVI View.  
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  The “n-D Class Controls” window pops-up with the 20 color-coded classes 
   Turn off the White pixels (I have 7048 white pixels).  The white  
   pixels are not end members (my understanding…).  I see a much  

   clearer picture of the 19 end members!  Do you? 
 

                     

 There are 20 MNF bands in the “n-D Controls” window (looks like a calendar)  
 They are color-coded in the “n-D Class Controls” window.  
  Try different 3-band combinations.  Turn off the active 3 bands, and then  
  select 3 new bands.  After a few combinations, try 18-19-20    > Start  

Question 14:  A.  What happens to the cloud when you load MNF bands 18-19-20 into  
  the n-D Visualizer? 

  B. What does the 3D shape of the 18-19-20 cloud tell you about coherent  
  spectral information and noise in these MNF bands? 

  
8) You can add your own end members by interpreting corners in the cloud  
 or by importing from a Spectral Library.  We will import our “alunite1”   
 spectral profile from our 14-band spectral library. 

 “n-D Controls” > Options > Import Library Spectra >   
 “n-D Visualizer Import Spectra” window pops-up >  
  Import   select   “from Spectral Library File>   
 “Spectral Library Input File” window pops up 
  If you don’t see our 14-band spectral library in the list, go to the “Open”  
  drop-down menu at the bottom of this window > choose “Spectral Library”  
  > drive to Lab_11_Data folder with our 14-band library > Select > Open  

  
 In the  “Spectral Library Input File” window  our 14 band library file displays at the 
 top of the list> 
  Select  “USGS_Min_Spec_Cuprite_50band_14minerals.sli”  > OK  
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 The “Input Spectral Library” window pops up. 
  Select “alunite…”  accept defaults     > OK 
 
 Two more windows pop-up(!).   
  The “alunite1…” spectra is highlighted and the profile displayed in the  
  Spectral Library Viewer.   

  “alunite1…” is also highlighted in the  “n-D Visualizer Import Spectra”  
  window  > Apply   and then the second small window (“Import Spectra  
  Parameters”)  pops-up  >  Accept default color > OK 

  The Alunite1 position in the cloud is displayed and labelled! 

  Try to determine what if any PPI endmembers correlate spatially with the  
  USGS “alunite1…” spectra.  The magenta endmember (553 pixels) and  
  the dark brown endmember (2149 pixels) are often near the USGS   
  spectra as different bands are selected with the n-D Visualizer tool. 
 

 6) Let’s delete our Alunite1 point. “n-D Controls”  > “Options” > “Delete Library  
  Spectra” window pops-up > select “alunite1…” > OK 
 
 7)  In the Wizard’s N-DIMENSIONAL VISUALIZER page  
  > click on “Retrieve  Endmembers” 
  The 19 endmembers populate the Endmember List. 

  The “Plot Endmembers” and “Start Spectral Analyst” buttons are activated. 

 

  Click-on “Plot Endmembers” 
   The “n-D Visualizer Endmember Spectra” window pops-up. 
              (see window below) 
    
   Change from “Data Value” to “Continuum Removed” 
   Click on the “Stack Plots” icon   
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  Read through the text on the right side of the “n-D Visualizer Endmember  
  Spectra” window  below.  Note how similar these endmember spectra to  
  some of the spectral profiles we found while clicking around the AVIRIS  
  SWIR data set.   Muscovite (white mica).  Calcite.   
    

 

 
“n-D Visualizer Endmember Spectra” window 
 
“Data Value” changed to    
                             “Continuum Removed” 
 
Clicked on “Stack Plots” 
 
What endmembers have unique spectral 
profiles in the SWIR wavelength range? 
 
Experienced analysts can identify the material 
(minerals in our example) that is associated 
with a spectral profile on the left.   
 
“n-D Class Mean #2 (green profile 2nd from the 
bottom) is very similar to “muscovite” or “white 
mica”. 
 
“n-D Class Mean #5 (cyan profile 5th from the 
bottom) is very similar to “calcite”. 
 
The end member spectra can be exported from 
this menu as a spectral library using the 
“Export” dropdown menu!  Then you could do 
an excellent job comparing your endmember 
spectra to large spectral libraries and more 
accurately rename the endmembers.  You could 
also delete those endmembers that had spectra 
that was not in your area (based on field work 
and knowledge about materials in the scene. 
 
Also you could use the “Start Spectral Analyst” 
tool that is shown on the “N-Dimensional 
Visualizer” menu to help identify your 
endmember spectra. 
 
These are very powerful tools! 

 
The spectral signatures and names of the 19 endmembers are shown on the plot above 

 The profiles and list are in reverse order.  “n-D-Class Mean #1” is at the bottom 
 of the profile stack…n-D Class Mean#19 is at the top of the profile stack. 

 8) You should realize that several of these spectral profiles look like spectra in 
 our 14-band Spectral Library.  Read the text in the box above. 
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 Click-on the “Start Spectral Analyst” button in the Wizard’s N-DIMENSIONAL  
 VISUALIZER page 
  The “Spectral Analyst Input Spectral Library” window pops-up. 
  Select our 14-mineral Spectral Library (if it isn’t in the list, go to the   
  drop-down menu at “Open” > Spectral Library > and drive to our library  
  location in the Lab_11_Data folder and select > OK 
   

 The “Edit Identify Methods Weighting” window pops up. 
 We will use all three methods to evaluate our 19 endmember spectral profiles 
 so enter 0.33 in the three “Weight” windows.   >  OK    (see below) 

      

 A blank “Spectral Analyst” window pops up (see below at left) 
 Click Apply and a list with our 19 endmembers pops-up (see below at right) 

                  

 Select endmember #5 (we think this looks like Calcite) > OK 
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The “Spectral Analyst” window pops back up with a list of potential spectra that  match 
our endmember #5 – ranked by score.   (see below) 

                     #1 fit is Calcite! 

 Click on Help at the bottom of the Spectral Analyst menu to understand the 
 limitations and processes involved.  Some Help comments below. 

NOTE:  Use the Spectral Analyst to help identify materials based on their spectral 
characteristics. The Spectral Analyst uses ENVI techniques such as Binary Encoding, Spectral 
Angle Mapper, and Spectral Feature Fitting to rank the match of an unknown spectrum to the 
materials in a spectral library. 
The output of the Spectral Analyst is a ranked or weighted score for each of the materials in the 
input spectral library. The highest score indicates the closest match and indicates higher 
confidence in the spectral similarity. Similar materials may have relatively high scores, but 
unrelated materials should have low scores. 
This function does not identify spectra; it only recommends likely candidates for identification. 

Question 15:  A. Using the “Spectral Analyst” tool, click on “Apply” and select “n-D Class 
  Mean #9”.  What three closely related clay minerals have the highest  
  score? 

  B. Look at the profile of n-D Class Mean #9.  What is the term used to  
  describe the  unique spectral absorption feature between 2.17 and 2.21  
  µm? 

  C. Using the “Spectral Analyst” tool, click on “Apply” and select “n-D Class 
  Mean #4”.   What mineral has the highest score? 

 9) “Edit Names” in the Endmember List shown in the Wizard’s the Wizard’s N-
 DIMENSIONAL VISUALIZER page. 
  Change “n-D Class Mean #5” to “Calcite” 
  Change “n-D Class Mean #9” to the mineral with the top score. 
  Change “n-D Class Mean #4” to your answer above. 
   Your changes will show up on our next map!!   > Next 
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 10)  USER SUPPLIED ENDMEMBERS page.  We won’t add “User Supplied  
 Endmembers”.  If you did field work and  collected spectra, you could add your 
 spectra her to improve and validate your map.     > Next 

 11) MAPPING METHODS page.  Carefully read this section – excellent review of 
 the different methods! 

 Let’s just do one method – SAM with the default SAM Maximum Angle of 0.10  
   (uncheck MTMF and Unmixing methods)   > Next 

 12) The SAM process is completed and the Wizard page INVESTIGATE SAM 
 RESULTS page pops-up.  Read this explanation of SAM. 

 In the Data Manager you will see the SAM 19-class classification map (shown 
 below) and the SAM 19 Rule Images (grayscale). 
 
 Turn on your SAM classification map and the USGS Hyperspectral classification  
 map.   Turn all other layers off in the Layer Manager.  

 Highlight the SAM map in the Layer Manager.  Manually use the transparency 
 slider to fade the SAM map from opaque to transparent.  Answer Question 16. 

 
             Color composite of SWIR bands        SAM map with 19 classes 

Question 16:  Questions are based on the SAM classification map. 
  (Hint:  Use the “Cursor Value” tool to query the class shown on your map)  
  A. Is Calcite located in the same place as on the USGS hyperspectral  
  color map?   YES    NO 
 
  B. What is the “nD-Class  Mean #3 class on the USGS hyperspectral color 
  map? 



25 
 

25 Introduction to Remote Sensing  Principles, Interpretation, and Applications 
F. F. Sabins and J.M. Ellis, 2020, Waveland Press.    Contact:  jellis@ellis-geospatial.com 

 

  C. Right-click on the “Classes” folder under the SAM map in the Layer  
  Manager >   Select “Statistics for all Classes”.  In the “Data Selection”  
  window ensure the “cuprite…_sam_class” file is selected. 

   What are the three largest classes? 
   What are the three smallest classes (don’t include “Unclassified”)? 

  D. Does your classification map show spatially coherent classes? 
      YES    NO 

 13) SAM Rule images are grayscale probability images.  Each endmember has a 
 SAM Rule image.  The better the fit of the pixel to the endmember’s spectral 
 profile, the smaller the “spectral angle” and the blacker the pixels in the Rule 
 image.  Use the Cursor Value tool to query light and dark pixels in the Rule 
 images. 

 In the Data Manager, expand the “cuprite…._sam_rule” file so that the 19 
 endmembers are displayed.   
  
 Select the “Rule (Calcite)” > Load Grayscale  > contrast stretch “Linear 1%” 
  Calcite is the renamed “n-D Class Mean #5” 
  Use the Cursor Value tool to query the brightest and darkest pixels. 
   (you could also use the “Quick Stats” tool to get exact values). 
  
Question 17:  A. What is the SAM Rule value for the brightest pixel you find?  
  
  B. What is the SAM Rule for the darkest pixel you find? 

  C.  According to the USGS color geologic map, what mineral is located  
  where the Calcite SAM Rule map has the brightest pixels?  (meaning  
  spectra in these pixels are very different compared with calcite spectra). 
 
  C. Where are the darkest pixels located? 

Turn-off all layers in the Layer Manager.  Turn-on the colorful SAM classification map.
 File > Chip View To > Geospatial pdf 
 Leave the metadata blank…bad practice but this lab is too long! 
 Output Filename:  “YourName_SAM_map”    check “Display Result” 
 Upload your geospatial pdf to the instructor.   

Congratulations for completing this lab!  You now have some understanding of the 
potential for hyperspectral remote sensing to provide unique, very informative, and very 
detailed maps of material on the Earth’s surface. 
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Lab 11   Hyperspectral  Section 1                   Name: 

Hyperspectral VNIR Datacube for Vegetation Analysis 

Upload the following files to the instructor: 
 
 “YourName_5_Spectral_Profiles”   as a .png 
 
 YourName_3D_Datacube” as a .tif 
 

Question 1: What is the name of the unique sharp increase in brightness (Data Value) 
between 680 and 745 nanometers? 
 
Question 2: Why is the reflected brightness highest in the 520 – 600 nm range 
compared to the 400 – 520 nm and the 600 - 680 nm ranges? 
 

Question 3:  What causes the unique absorption feature for healthy vegetation that is 
between ~600 and 680 nm?  (Hint: think about what is causing the higher reflectance 
values at shorter and longer wavelengths?) 
 
 

Question 4:  A. What is the calculated NDVI value for your brightest (most vigorous)  
  pixel? 

  B. What is the calculated NDVI value for the gray terrain (in the color IR  
  image gray may represent dormant, dry grasses and other ground   
  vegetation)? 

  C. How did the program calculate NDVI?   
 

Question 5:  Discuss what happens to VNIR spectral profiles when you move from 
vigorous vegetation to no vegetation (barren terrain). 
 

Question 6:   A. Do you think there is new information and patterns in the classification  
  map about vegetation, soils, barren ground, etc. that made our MNF and  
  isoDATA effort worthwhile?    YES    NO   

  B. Do you see shadows in the classification map?  If so, what class   
  number represents many shadows? 

  C.  What class number represents the most vigorous vegetation? 



27 
 

27 Introduction to Remote Sensing  Principles, Interpretation, and Applications 
F. F. Sabins and J.M. Ellis, 2020, Waveland Press.    Contact:  jellis@ellis-geospatial.com 

 

Lab 11   Hyperspectral Section 2                   Name: 

Hyperspectral SWIR Datacube for Geologic Mineral Mapping 

Upload the following file to the instructor: 
 
 “YourName_SAM_map”  as a pdf (at the end of the lab)  
 

Question 7:   A. Do you find the absorption feature of alunite is relatively consistent  
  between the pixels in the hyperspectral data set and the USGS Spectral  
  Library?   YES   NO 

Question 8:  A. What mineral is represented by the green color in the USGS color map?  

  B. What is the wavelength of the absorption feature in both the   
  hyperspectral data and in the spectral library? 

Question 9:   A. Do you find pixels with the deepest absorption feature at ~2.21 µm? 
  YES    NO 
 
  B. Do you find pixels with the “doublet” absorption feature?  (two   
  absorption features next to each other)   YES    NO 

  B. What is the wavelength for the deepest absorption feature for dickite  
  and halloysite in the spectral library?  

Question 10:  A. What is the wavelength of the absorption feature for “muscovi1” (white  
  mica) in the spectral library? 

  B. Describe the difference between the shape of the absorption feature of  
  kaolinite and  muscovi1 (white mica). 
 

Question 11:  A. What often happens to the depth of the first absorption feature in the  
  kaolinite doublet (~2.16 µm) when alunite is mixed in? 
 

Question 12:  A. What do you visually see as a reasonable number of MNF bands to  
  use going forward?  (relatively clean data, not much noise).    

 

Question 13: A. What “Threshold Level” did you decide to use and how many MNF  
  bands does the ENVI program recommend using going forward?   
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Question 14:  A.  What happens to the cloud when you load MNF bands 18-19-20 into  
  the n-D Visualizer? 

  B. What does the 3D shape of the 18-19-20 cloud tell you about coherent  
  spectral information and noise in these MNF bands? 

Question 15:  A. Using the “Spectral Analyst” tool, click on “Apply” and select “n-D Class 
  Mean #9”.  What three closely related clay minerals have the highest  
  score? 

  B. Look at the profile of n-D Class Mean #9.  What is the term used to  
  describe the  unique spectral absorption feature between 2.17 and 2.21  
  µm? 

  C. Using the “Spectral Analyst” tool, click on “Apply” and select “n-D Class 
  Mean #4”.   What mineral has the highest score? 

Question 16:  Questions are based on the SAM classification map. 
  (Hint:  Use the “Cursor Value” tool to query the class shown on your map)  
  A. Is Calcite located in the same place as on the USGS hyperspectral  
  color map?   YES    NO 
 
  B. What is the “nD-Class  Mean #3 class on the USGS hyperspectral color 
  map? 

  C. Right-click on the “Classes” folder under the SAM map in the Layer  
  Manager >   Select “Statistics for all Classes”. 

   What are the three largest classes? 
 
   What are the three smallest classes? 

  D. Does your classification map show spatially coherent classes? 
  YES    NO 

Question 17:  A. What is the SAM Rule value for the brightest pixel you find?  
  
  B. What is the SAM Rule for the darkest pixel you find? 
 
  C.  According to the USGS color geologic map, what mineral is located  
  where the Calcite SAM Rule map has the brightest pixels?  (meaning  
  spectra in these pixels are very different compared with calcite spectra). 

  D. Where are the darkest pixels located? 


